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Abstract 

Flooding is the leading cause of losses from natural disasters in the United States, 

responsible for over 140 deaths a year (United States Geological Survey [USGS], 2006 

and 2012). Dynamic inundation mapping, or using continuous modeling in conjunction 

with a GIS-system to create maps of flooded areas under different scenarios, has the 

possibility to better predict flooding by taking into account environmental conditions 

preceding and during the flood ( such as soil moisture, rainfall spatial heterogeneity and 

timing).  This study examines the effect of hydrologic-hydraulic model linkage schemes 

in generating inundation maps and understanding the uncertainties involved, with an eye 

towards improving operational use.   

The Hydrology Laboratory’s Research Distributed Hydrologic Model (HL-

RDHM) was used to generate inputs to the Army Corps of Engineers Hydrologic 

Engineering Center’s River Analysis System (HEC-RAS) hydraulic model for two 

simulation time periods (September to December 1999 for the simulation of flooding due 

to Hurricane Floyd and from June to October 2006 for flooding due to Tropical Storm 

Alberto) in the Lower Tar River sub-basin for four different hydrologic-to-hydraulic 

model connection scenarios of increasing complexity and increasing number of inflow 

points.  The HEC-GeoRAS, an extension built for use with ArcGIS to pre-process and 

post-process HEC-RAS geometric data, was used to generate inundation maps from the 

maximum water surface produced during each simulation time period.   
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The stage and flow simulated by the hydraulic model were compared to observed 

data recorded by USGS gauges and the goodness of simulation was assessed using the 

Nash-Sutcliffe Efficiency (NSE).  The most detailed scenario slightly outperformed the 

less detailed scenarios for simulation of flow and stage at gauges on the main stem of the 

Tar River for the both simulation periods (NSE >0.89).  No scenario did a good job of 

simulating the stage or flow on the tributaries of the Tar River (NSE <0.52).  For the 

1999 simulation, the flood elevation predicted by the inundation map was compared to 

high water marks collected by the Federal Emergency Management Agency (FEMA) and 

the USGS after Hurricane Floyd.  All scenarios generally predicted flooding well, with 

mean error of around 1 foot for the less complex, more calibrated models, around 1-1.5 

feet for the more complex models, and mean absolute error for all scenarios around 3.5-4 

feet.  The time required to generate these simulations and maps was not greatly increased 

with increasing modeling complexity, though the models did require careful set-up to 

ensure stability.  The results of this work suggest modest benefits in accuracy of 

modeling stage and flow by increasing the number of inputs from a hydrologic model to a 

hydraulic model.  Mapping results show limited statistical gain, but some importance of a 

multi-stem model in order to create inundation maps which include flooding effects on 

tributaries. Lack of observed data to provide boundary conditions, and reliance on input 

data with its own set of uncertainties seem to dominate uncertainty in tributary models 

unforced by observed data.  
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1. Introduction  

1.1 Background 

Flooding is the leading cause of losses from natural disasters in the United States, 

accounting for over 75% of declared Federal disasters (United States Geological Survey 

[USGS], 2012).  These floods cause around 140 deaths each year and an estimated $6 

billion in losses. Although the number of deaths due to floods has declined over the last 

50 years, economic losses have increased due to population growth and urbanization, 

especially in coastal areas (USGS, 2006).  In 2010, over half of the US population (52%) 

lived in coastal communities, a figure which is expected to increase 9% by 2020 

(National Oceanic and Atmospheric Administration [NOAA], 2012).  This projected 

increase in growth, combined with recent large flood events in the United States and 

worldwide, have led many countries to place an increased focus on mitigation of and 

preparing for flooding and its associated hazards (Brocca, Melone & Moramarco, 2011). 

The most common causes of flooding in the Eastern United States are hurricanes 

and storms (USGS, 2006).  Factors that affect whether rainfall from these systems will 

cause flooding include the conditions which precede the storm, including soil moisture 

conditions, and the characteristics of the storm itself, especially the rainfall duration and 

extent compared to the size of the basin (Bales, Oblinger & Sallenger, Jr., 2000).   In 

order to understand the timing and magnitude of floods, as well as for contingency 

planning and management decisions, river modeling and inundation mapping have 

become increasingly important tools.  
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1.2 River Modeling and Inundation Mapping 

Inundation mapping is a way to represent flooding for use in determining current 

flooding extent or areas forecasted to flood.  This is useful information for emergency 

managers, rescue workers, and citizens who would be impacted by possible evacuations.  

This is commonly performed by linking GIS and hydrologic/hydraulic models, which 

then can be used to display the flood extent (Colby, Mulcahy & Wang, 2000).  Current 

engineering practice is to use a rainfall-runoff model to simulate a design storm of a 

given recurrence interval and to convert the peak flow to stage using a steady state 

hydraulic model, assuming the design storm and the generated water level will have the 

same return period, which may not be true depending on other environmental or storm-

specific conditions (Bradley, Cooper, Potter & Price, 1996).  This peak stage is used to 

determine water levels which are used to generate a map of flooding for the design event.  

Flood mapping for insurance planning, to “attempt to prevent or reduce flood 

damages” has been carried out by the National Flood Insurance Program of Federal 

Emergency Management Agency (FEMA) for over 40 years (Bales & Wagner, 2009).  

These maps identify areas which correspond to a few given exceedance levels, or the 

likelihood that an area will be flooded during a storm event.  Mapping by the National 

Weather Service occurs at distinct forecast points and reflect a large range of multiple 

water levels and discharge values.  These static maps are compiled to create a library 

which encompasses water levels considered minor flooding up to the largest flood of 

record, which can then be used for flood warning purposes (Real-Time (Dynamic) 

Inundation Mapping Evaluation (R-Time) Team, 2007).    
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1.3 Current Efforts 

1.3.1 Current Modeling Efforts 

The National Weather Service (NWS) of the National Oceanic and Atmospheric 

Administration (NOAA) produces forecasts at around 4,000 points across the United 

States, generated by 13 River Forecast Centers (RFCs).  These forecasts and river 

observations are made available to the public through the Advanced Hydrologic 

Prediction Service, or AHPS at water.weather.gov/ahps.  To create these forecasts, the 

NWS uses hydrologic models, and, to a more limited extent, hydraulic models. However, 

the extent of these predictions in coastal areas is quite limited.  According to Van Cooten 

et al. (2011), of the 142 Atlantic and Gulf of Mexico coastal drainage areas, or the 

downstream-most basin areas that drain directly to the ocean or an estuary, over 90% do 

not receive any forecast information about water level or streamflow from the NWS, 

partially because of the burden that implementing new hydrologic models in these areas 

would entail, let alone hydraulic models which could accommodate tidal or backwater 

influences.   

However, this absence does provide a big opportunity for service expansion.  

With this in mind, the NWS currently models 5,500 miles of river with hydraulic models.  

For its ease of use by forecasters and wide support among the engineering community, 

these models have been converted to HEC-RAS, a dynamic hydraulic model which has 

the ability to include several points of interest for forecasting, less reliance on observed 

field data as compared hydrologic models, ease in calibrating the model to reflect 

seasonal hydraulic property changes, and the ability to estimate values for future floods 

(Reed, 2010).   
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1.3.2 Current Mapping Techniques 

Flood forecast maps provide valuable information to emergency managers and the 

public. The NWS currently provides static flood map libraries tied to river forecasts at 

about 65 points in the United States. However, many more communities could benefit 

from expanded flood forecast mapping services. Dynamic modeling and mapping is a 

promising approach to efficiently expand forecast mapping services. Dynamic models 

may be used to extend maps farther distances from forecast points and to tributaries 

where services are desired. 

1.4 Needs and Shortcomings of Current Methods 

Current techniques have many benefits, including that hydrologic models are 

widely applied, well-tested, and integrated with current forecasting systems.  Static flood 

maps are quickly called upon, easily distributed, always available, and provide a useful 

resource for planning (Real-Time (Dynamic) Inundation Mapping Evaluation (R-Time) 

Team, 2007).  However, there are many drawbacks and areas of current methods that 

could be improved upon by further studies.  A few of these are outlined in the following 

section. 

1.4.1 Benefits of Hydraulic Models as Compared to H ydrologic 
Models 

Routing techniques may be classified into two major categories: simple catchment 

hydrologic routing involving the continuity equation, and more complex channel 

hydraulic routing requiring both the continuity and momentum equations. However, most 

comprehensive hydrologic models today incorporate hydraulic routing components. 
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Hydrologic routing tends to include more components (e.g., rainfall, infiltration, 

evapotranspiration, balancing of inflow, outflow and storage through various phases). 

Further distinctions are made in Section 2.  

Although numerous hydraulic models are being used by the NWS for forecasting, 

the current extent of this practice is only a fraction of the estimated 26,000 miles which 

would be predicted to benefit from such hydraulic modeling.  However, hydraulic models 

are not more widely implemented within the NWS forecasting system for a number of 

reasons.  The three mentioned by Reed (2010) are that forecasters are not convinced that 

hydraulic modeling is worth the financial investment required to set-up and maintain 

these models, secondly, that the complexities involved in setting up and model and 

achieving stability give hydraulic models a reputation of being difficult to use, and third, 

that many forecasters may have developed their own techniques in compensating for the 

shortcomings of hydrologic models. 

1.4.2 Limitation of Models 

One of the big challenges in implementing tributary hydraulic models is that 

accurate hydrologic inflow forecasts may not be available. NWS River Forecast Centers 

(RFCs) primarily run lumped hydrologic models, producing flow information only at 

basin outlets. Implementing multi-reach hydraulic models on tributaries will require use 

of a distributed hydrologic model to provide boundary conditions.  

Models must be chosen with their limitations in mind.  Model complexity, while 

increasing resolution and possibly increasing accuracy, must be balanced with the data 

and computing requirements.  Additionally, for operational use, the training and system 

implementation cost and time required are also factors in model selection and use. 
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1.4.3 Issues with Static Mapping 

Currently NWS flood forecast maps exist only in static map libraries.  These are 

created for the areas near 65 or so forecast points.  These maps are limited in application; 

each map only covers a river length area of around 4 kilometers.  Their effectiveness 

decreases with distance from the forecast point, especially in areas where high-resolution 

topographic data is not available or where land cover changes too rapidly in time to be 

reflected in maps, they may not be implemented in regions with tributary inflows or 

possible backwater effects, or where there are tidal influences.  These are some of many 

reason dynamic mapping is being explored as a way of expanding the coverage of 

inundation maps (Real-Time (Dynamic) Inundation Mapping Evaluation (R-Time) Team, 

2007). 

1.5 Objective 

The purpose of this study is to explore the effect of hydrologic-hydraulic model 

linkage schemes in generating inundation maps and understanding uncertainty involved 

with an eye towards improving operational use.  Although numerous studies have looked 

at the uncertainty involved in mapping and ways to link hydrologic and hydraulic models, 

the most widely-used framework being used for nationwide operational forecasting has 

not been tested in such a way as to quantify uncertainty involved with generation of 

inundation maps, with the possibility of improving current or future modeling and 

mapping efforts.  The goals of this study were to create various scenarios to represent 

possible linkage schemes representing different levels of detail at which distributed 

hydrologic model outputs are used to create boundary conditions for hydraulic models, to 

use these different model scenarios to evaluate the accuracy of flow simulations and 



 

7 

inundations maps as compared to an historic flood, and evaluate the suitability of the 

model in simulating other floods outside the than the calibration period. 

2. Literature Review 

2.1 Hydrologic Models 

Hydrologic models rely on the parameterization of watershed properties and 

rainfall patterns and depths to produce a flood hydrograph of discharge at discrete time 

steps.  These models have become widely used in flood forecasting, stream flow 

prediction, and to quantify effects of climate change, land use impacts or other spatially 

distributed properties.  However, their limited routing methods do have some drawbacks 

in simulating flows in large watersheds (Mai, 2009). 

Two main types are lumped hydrologic models and distributed hydrologic 

models.  Lumped hydrologic models only consider generalized watershed characteristics, 

and are only able to produce streamflow hydrographs at the basin outlet.  Distributed 

hydrologic models, on the other hand, can accommodate spatial heterogeneity of land 

use, soil properties, rainfall, and other inputs.  This quality allows for higher resolution 

simulations and predictions which can improve operational forecasts, however, with this 

higher resolution comes more complexity and uncertainty (Carpenter & Georgakakos, 

2006). The benefit of a distributed model as compared to a lumped hydrologic model is 

that once a distributed model is calibrated, it can be used to predict future events under 

changed conditions (such as different land use or spatially varying environmental 

parameters affected by climate change) where a lumped model would have to be 

completely reformulated (Nunes Correia, Castro Rego, da Graça Saraiva & Ramos, 

1998). 
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Commonly used hydrologic models include the Hydrologic Engineering Center – 

Hydrologic Modeling System (HEC-HMS), the Hydrologic Simulation Program-

FORTRAN (HSPF), Soil and Water Assessment Tool (SWAT), and MIKE-SHE (Bertie, 

et al., 2011; Debele et al., 2006; Haghizadeh et al., 2012; Lian et al., 2007). 

2.1.1 HL-RDHM 

The Hydrology Laboratory – Research Distributed Hydrologic Model, or HL-

RDHM, is a “flexible, stand-alone tool for distributed hydrologic modeling research and 

development” developed by the Hydrologic Science and Modeling Branch (HSMB) of 

the NWS Office of Hydrologic Development (OHD) Hydrology Laboratory (HL) and is 

used to validate scientific techniques which then may become part of the operational 

software of the NWS (HL-RDHM user manual v. 3.0.0, 2009).   

The HL-RDHM calculates runoff based on the distributed procedures of the 

Sacramento Soil Moisture Accounting model with the Heat Transfer component (SAC-

SMA-HT).   The forcings of SAC-SMA-HT include gridded precipitation and 

temperature data, along with daily or monthly potential evapotranspiration.  The model 

calculates water storage within the soil profile in generalized upper and lower zones of 

soil moisture, which are further classified into free water and tension water.  Tension 

water in the upper zone is water which when added to dry soil, does not leave the zone.  

Water in the upper zone enters from precipitation through permeable soil areas.   Lower 

zone tension water is considered to be water which is held by molecular forces to soil 

particles (NWSRFS User’s Manual Release 81, 2005).   

The effect of evapotranspiration on soil moisture is included in the model by 

calculating a balance of evapotranspiration demand with available soil tension water in 
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the upper zone, with excess moisture supplied by water in the lower zone.  Free water can 

also be lost from the upper zone to the lower zone based on the nonlinear percolation rate 
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where I0 is the minimum percolation rate under fully saturated conditions, Imax is the 

maximum percolation rate, �  is a curve-fitting exponent, Sf,i is the free water storage 

capacity for the upper zone (1), the fast baseflow component of the lower zone (2), or the 

slow baseflow component of the lower zone (3), and St,i is the tension water storage for 

these same zones (Koren, Smith, Cui & Cosgrove, 2007).   

When tension water in the upper zone is at capacity, runoff can be produced 

through five methods:  from impervious surfaces or direct runoff from water flooded 

areas, from surface runoff when upper zone free water is also full and when precipitation 

exceeds percolation rates, interflow from lateral upper zone drainage, or from primary 

baseflow (RDHM User Manual v. 3.0.0, 2009). This runoff can be conceptualized as qi 

 
t

Sr
q ifi

i D
= ,        (2)   

where Sf,i represents the linear free water reservoirs for the i different water storage zones 

mentioned previously, ri is the constant depletion coefficient for each reservoir and � t is 

the time interval (Koren, et al., 2007).  More details regarding these concepts can be 

found in the HL-RDHM user’s manual v. 3.0.0 (2009). 

2.2 Hydraulic Models 

Hydraulic models are based on the solutions to the St. Venant equations 

(described in more detail in the next section) to calculate open channel flow.  The most 
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commonly used of these models are either one-dimensional or two-dimensional.  Even 

one-dimensional models require inputs of cross-sectional geometry, roughness, and 

boundary conditions, while fully two-dimensional models require inputs of topography, 

roughness, wind resistance, and boundary conditions for solution of the 2-D St. Venant 

equations, typically via a finite element approach.  Mai (2009) describes how, although 2-

D hydraulic models provide satisfactory results, the data coverage requirement, the 

inability to rapidly adjust these models to assess catchment or river channel change, and 

the computational demands of 2-D models all serve as drawbacks to their 

implementation.  Instead, a 1-D model is often used to determine stage, which is then 

interpolated in a GIS system to produce a flood map. 

Widely used hydraulic models include Water Quality Analysis Simulation 

Program (WASP), CE-QUAL-W2, Environmental Fluid Dynamics Code (EFDC), EPD-

RIV1, Hydrologic Engineering Center – River Analysis System (HEC-RAS), MIKE11 (a 

1-D model), MIKE21 (2-D model), and SOBEK (Bertie, et al., 2011; Debele et al., 2006; 

Haghizadeh et al., 2012; Horritt &Bates, 2002). 

2.2.1 Mathematical Foundations 

The underpinnings of these models are the conservation of mass and momentum 

for a shallow water control volume.  In one-dimension, these are expressed by the 

continuity equation: 

0=
¶
¶

+
¶
¶

t
A

x
Q

      (3) 

where Q is the discharge, t is time, x is the channel distance, and A is the cross-sectional 

flow area, as well as the momentum equation:  
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    (4) 

where g is gravitational acceleration, S0 is the channel bottom slope and Sf is the friction 

slope. 

These two equations taken together are the St. Venant equations, upon which 

hydraulic models are based. The first term is the local acceleration, the second accounts 

for convective acceleration, the third is the pressure force term, and the fourth and fifth 

are the gravity and friction force terms, respectively.  Those models which simplify these 

equations to only the rightmost two terms (gravity and friction forces) are known as 

kinematic wave models.  Diffusion wave models are those which include all but the 

inertial terms.  Those models which solve the full St. Venant equations are known as 

dynamic wave models (Bedient, Huber & Vieux, 2008). 

2.2.2 HEC-RAS 

HEC-RAS is a product of the United States Army Corps of Engineers Hydrologic 

Engineering Center and is “an integrated system of software…comprised of a graphical 

user interface (GUI), separate hydraulic analysis components, data storage and 

management capabilities, graphics and reporting facilities” (HEC-RAS User’s Manual 

Version 4.1, 2010).  The program code is public domain software available as a free 

download from the HEC website.   

HEC-RAS computes hydraulic analysis components for steady flow which 

involves solution of the one-dimensional energy equation, unsteady flow through the full 

solution of the 1-D St. Venant equations or dynamic wave, and sediment transport.  



 

12 

Using implicit finite differences, Equation 3 is approximated for channel and floodplain 

(out-of-bank) flow as   

f
c

c

c q
t
A

x
Q

=
D
D

+
D
D

       (5) 

for the exchange of water from floodplain (q̄f), where Qc is channel flow, Ac is channel; 

cross-sectional area, xc is the distance along the channel, and t is time, and 
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for the exchange of water from channel (q̄c), where Qf is flow in the floodplain, S is 

storage in non-conveying portions of the floodplain, and q̄l is the lateral inflow per unit 

distance.  These equations are then combined and rearranged to give 
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where Q̄l is the average lateral inflow, which is the continuity equation solved for by the 

HEC-RAS functions (HEC-RAS Hydraulic Reference Manual Version 4.1, 2010).   

Similarly the momentum equation as given in Equation 4 is rewritten for the channel and 

floodplain components, assuming the same water surface elevation in the channel and in 

the floodplain.  Approximating the momentum fluxes per unit distance for both the 

channel and floodplain using finite differences yields Equations 8 and 9 
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where V is the velocity either in the channel or floodplain, g is the acceleration due to 

gravity, and Sf is the friction slope of their the channel or the floodplain.  These can be 

combined and simplified into Equation 10, 

 
( ) ( ) 0=D+D+D+

D

D+DD
ef

ffcc xSAgzAgVQ
t

xQxQ
b   (10) 

where �  is the velocity distribution factor,  Ā is Āf+Āc, � xe is the equivalent flow path, 

and Sf represents the frictional slope for the whole cross section.  At junctions, additional 

momentum from the entering tributaries is added to this equation as Ml, 

x
VQ

M ll
l D
= x       (11) 

where �  is the fraction of momentum entering the main river channel, Ql is the lateral 

inflow, and Vl is the lateral inflow average velocity. This is added to the right side of 

Equation 10 to form a complete momentum equation for multi-reach models.   More 

details on these equations and the methods HEC-RAS uses to solve them can be found in 

the HEC-RAS Hydraulic Reference Manual.   

HEC-RAS is well-tested and in use by the National Weather Service for hydraulic 

modeling as a part of the Community Hydrologic Prediction System (CHPS) (Roe, Dietz, 

Restrepo, Halquist, Hartman, Horwood, Olsen, Opitz, Shedd & Welles, 2010).  However, 

this model makes many simplifications, including that flow can be represented by a mean 

velocity in a cross section, that the water surface is horizontal across the cross section, 

that vertical acceleration and complex floodplain flows can be neglected, and that 

Manning’s equation can be used to approximate uniform flow (Pappenberger, Beven, 

Horritt & Blazkova, 2005). 
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2.3 Importance of Lateral Inflows 

Due to the aforementioned assumptions made by the model, many of the 

uncertainty quantification studies examining flows modeled in HEC-RAS have focused 

on the determination of roughness coefficients.  However, Pappenberger, et al. (2005) 

mention in their study that boundary conditions do play a role in the uncertainty of a 

model, in that a downstream boundary can determine whether flow in the main channel is 

channel flow dominated or floodplain dominated in order to match the water balance at 

the downstream boundary condition.  This has important implications for flood mapping. 

Scharffenberg and Kavvas (2011) explored uncertainty in a kinematic wave 

hydraulic model for a stream with lateral boundary conditions.  They define this lateral 

boundary condition as “the difference between the upstream boundary condition and the 

downstream result”.  This can be applied uniformly along the channel, or as the authors 

do, modeled as a computed flow ratio.  Importantly, they state that “boundary condition 

uncertainty is quite broadly the most significant source of uncertainty” and that “the 

effect of uncertainty in boundary conditions may double the total uncertainty compared to 

the routing parameters alone”, however, studies to quantify this effect are not widely 

found in the literature.   

2.4 Coupling of Hydrologic and Hydraulic Models 

It is common to use a one-dimensional hydraulic model coupled with GIS to 

produce inundation maps, but it is also quite common to couple hydrologic and hydraulic 

models for simulation use.  There are three main levels of this coupling: full coupling, 

internal coupling or tight coupling and external or loose coupling (see Haghizadeh, Shui, 

Mirzaei, & Memarian, 2012, or Betrie, van Griensven, Mohamed, Popescu, Mynett & 
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Hummel, 2011).  Full coupling involves complete reformulation and solution of the 

governing equations, while tight or internal coupling involves solution of all model 

equations, and then iterative updating of shared model data (Haghizadeh, et al., 2012).  

The most basic is loose, or external, coupling in which two models exchange data via an 

external intermediate program, which does not change model code and is a lower cost 

procedure (Betrie, et al., 2011). 

According to Nunes Correia, et al., (1998) the first efforts in coupling hydrologic 

and hydraulic modeling for inundation mapping purposes was the creation of HEC-SAM 

(Spatial Analysis Methodology) by the Hydrologic Engineering Center in 1975, which 

combined the HEC-1 hydraulic model and kinematic wave routing with a GIS grid.   

Recently, combining hydrologic models with hydraulic models to simulate backwatering 

or looped rating curves has been examined for river system modeling.   

Debele, Srinivasan & Parlange (2008) externally linked the hydrologic model 

SWAT with the two-dimensional hydrodynamic CE-QUAL-W2 model, by simulating 

upland water quality variables and using the time series outputs from this model as inputs 

to the hydrodynamic model.  Most of the observed data were reproduced in this study, 

and failures to reproduce some results were attributed to poor quality of input data for 

some modeled water quality constituents and error propagation in calculations. Mai 

(2009) coupled the WetSpa distributed hydrologic model with HEC-RAS for the 

simulation and flood prediction of a flood-prone river basin in central Vietnam, both of 

which were calibrated and validated, and showed good agreement with observed peak 

flood levels.   
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Lian, Chan, Singh, Demissie, Knapp & Xue (2007) linked the hydrologic model 

HSPF with the one-dimensional hydraulic model UNET in order to capture the 

complicated hydraulics of the Illinois River.  They compared the linked model and HSPF 

alone to see how well the models reproduced historical flows.  Their work found a 

decrease in error of simulated flood peaks as compared to observed peaks, and slight 

increases in efficiency of the coupled model in daily, monthly and annual flows, though 

this decreased with increasing time period.  These studies show the possible 

improvements that can be realized through model coupling. 

2.5 Inundation Mapping 

One of the most basic methods for inundation mapping is using a 1-D hydraulic 

model to generate a water surface elevation at a given location, which is then 

extrapolated across a digital elevation model (DEM) to determine which areas would be 

inundated during a flood event.  Wang (2002) used measured surface water heights at 

USGS gauges projected over a DEM to represent flooded areas in the Tar River Basin 

during Hurricane Floyd.  The benefits of this method were the reliability and accuracy of 

the flood extent, as verified by satellite imagery, simple and cost-effective methods in 

creating the map, and easy creation of scenarios not directly observed, but that might be 

of interest for planning or management decision-making.  However, these data must be 

updated to reflect changes in land use, annual precipitation and changing inundated or dry 

areas during a flood event to maintain accuracy. 

The next step in model coupling using a 1D model is the use of a GIS system to 

create inundation maps from a water surface.  In a typical engineering study, Chang, Hsu, 

Teng & Huang (2000) linked a 1-D hydraulic model with a 2-D diffusive overland model 
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in the floodplain to simulate flow and inundation for 100-year and 200-year 24-hour 

design rainfall, using GIS to determine parameters for the model as well as to estimate 

inundation levels across the watershed.  This configuration was suitable to make 

engineering design recommendations for possible inundation proofing methods to be 

undertaken in the watershed.   

Nunes Correia, et al., (1998) coupled a GIS system with two different hydrologic 

models (one lumped and one distributed), as well as a hydraulic model to correctly 

represent backwater effects in the catchment.  They noted a weakness of GIS systems for 

mapping being that there is no easy or effective way to process or display time based 

processes in GIS.  This means that creation of a time series of data requires separate 

processing for each time step, increasing the amount of work required, especially if the 

model is coupled more tightly from start to finish, instead of more loosely.  

2.6 Previous Studies of the Tar River Basin 

Bales and Wagner (2009) examined the uncertainty involved in inundation 

mapping, focusing on the storm event during Hurricane Floyd in 1999 in the Tar River 

Basin in eastern North Carolina.  They found drawbacks in using a 1-D hydraulic model, 

namely that for complicated channel geometry, the assumption of a uniform water 

surface across a cross section may not hold if a cross section crosses multiple channels, 

and that uncertainty increases with distance from the main channel in low basins with 

multiple tributaries, however good agreement between observed and simulated stage and 

discharge was also found.   

Colby, Mulcahy & Wang (2000) also studied inundation mapping in the Tar River 

Basin after Hurricane Floyd, through generation of a water surface profile in HEC-RAS 
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and linkage with a GIS system through the ArcGIS extension HEC-GeoRAS, as well as 

through interpolation of measured water surface to create an inundation profile on a 

DEM.  This study found that both methods better represented actual flooding as recorded 

by aerial photographs than did estimation of flooded areas from flood insurance maps 

showing probability of inundation based on recurrence interval.  The authors suggest the 

accuracy of the mapping is limited to the estimated error of the DEM used, and qualify 

their results with the observation that “standard methods have not yet been developed for 

qualitatively evaluating the horizontal extent of floodplain boundaries. 

Van Cooten et al. (2011) simulated flooding in the Tar River basin by linking HL-

RDHM with the two-dimensional ADCIRC model.  They found good agreement between 

total water level and significant wave heights between the modeled and observed data, 

especially at high-flow events.  One difficulty encountered in this project was that HL-

RDHM is a hydrologic model which cannot consider backwater effects, which is 

especially important in a system such as the Tar River where tidal effects can be seen far 

upstream, and where storm surge can play a part in flooding.  The authors suggest the 

possibility of having the hydrologic model provide inputs to a hydraulic model, which 

can then be linked to the hydrodynamic model, instead of extending the hydrodynamic 

model far upstream of where storm surge would be predicted. 

Cepero-Pérez (2009) obtained and georeferenced a HEC-RAS model for the main 

channel of the Tar River.  This study examined the ability of a steady state hydraulic 

model to reproduce inundation due to Hurricane Floyd.  The study found that the 

accuracy is higher closer to the upstream boundary and decreases in the lower parts of the 

reach, which was attributed to error propagation in the downstream direction. 
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3. Methods 

3.1 Study Area 

Located in eastern North Carolina, the Tar River has its headwaters near Oxford, 

NC, and becomes the Pamlico River at Washington, NC.  According to the North 

Carolina Division of Water Quality [NC DWQ] (2010), the Tar-Pamlico River basin is 

the fourth largest in the state, and covers a total of 6,148 miles from its origin in north 

central North Carolina in the Piedmont physiographic area to where it empties into the 

Pamlico Sound.  Of the land in this watershed, over half (55%) is considered wetland and 

forested area, with a bit less than one third (28%) of the land used for agriculture, while 

the remaining 7% is classified as developed land, which occurs mostly in the towns of 

Rocky Mount and Greenville (NC DWQ, 2010). 

Only one-third of the basin is located within the Piedmont, which is characterized 

by easily eroding soils and underlying rock with little water holding capacity.  Streams 

here have low summer flows and there are few natural lakes.  Waters in the Coastal Plain, 

which is comprised mostly of deep sands with high groundwater storage capacity, 

comprise a majority of the watershed and are typified by swamps and estuaries, with 

many slow-moving streams.  Even the Tar River in this region can experience saltwater 

intrusion, due to the combination of low topography and wind and tidal effects.  There 

are over 2,500 miles of mapped streams within the watershed, and many more 

intermittent or ephemeral waterways.  The Tar River basin can be subdivided into five 

sub-basins, which are, from most upstream: Upper Tar River sub-basin, Fishing Creek 

sub-basin, Lower Tar River sub-basin, Pamlico River sub-basin, and Pamlico Sound sub-

basin (NC DWQ, 2010). 
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The focus area of this study concentrates on the 50 miles of the Tar River between 

Tarboro and Washington, NC, known as the Lower Tar River sub-basin.  Four main 

tributaries of the Tar in this sub-basin were also selected for modeling as part of this 

study: Town Creek, Conetoe Creek, Grindle Creek and Tranters Creek.  This area of the 

basin is shown in Figure 1 below.  Current NWS hydraulic models used in forecasting 

only cover the basin down to Greenville, and so do not encompass the extent of the 

modeling used in this study.  This means currently generated inflow calculations are not 

suitable for use in this modeling scheme.  This project examined a finer scale than what is 

currently modeled, at a further downstream and tidally-influenced location.  
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Figure 1: The extent of the main stem model from Tarboro to Washington, 

NC is shown in dark blue, with the tributaries modeled shown in purple.  The 
current basin forecast extent is shown in orange. USGS gauges are also shown. 
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3.2 Study Time Period 

The flood of record for this basin, as well as for much of eastern North Carolina 

was that which resulted from Hurricane Floyd in September of 1999.  During the summer 

of 1999, much of North Carolina was in a severe drought, with only 2.75 inches of 

rainfall in Wilmington and 6.39 inches in Raleigh recorded during the previous 12 

months.  On September 5, Tropical Storm Dennis passed across the state, dropping up to 

7 inches of rainfall in parts of the Tar River basin (Bales et al., 2000).  Floydwas a much 

larger hurricane, and made landfall only 10 days later as a Category 3 storm with 130 

mile per hour winds near its eye and tropical storm force winds which extended out 

across its entire 580 mile span (Herring, 2000).  Some parts of eastern North Carolina 

received around 60% of their yearly average total rainfall in only two weeks, due to the 

passage of Hurricanes Dennis and Floyd (Colby, Mulcahy & Wang, 2000), with over 15 

inches of precipitation falling over much of the Tar River basin. A map of the 

precipitation from the National Weather Service Event Summary is shown in Figure 2. 

 

Figure 2: Precipitation in North Carolina due to Hurricane Floyd.  Some of 
the heaviest precipitation occurred in parts of the Tar River basin on September 16, 

1999. 
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Hurricane Floyd resulted in 52 deaths and an estimated $6 billion in economic 

losses (Bales, et al, 2000).  The severity of the storm has made it the storm of record and 

source of study for many projects involving flood modeling and mapping. 

Another large and well-documented period of flooding occurred during the summer 

of 2006.  In their Event Summary, the National Weather Service office in Raleigh, NC 

(2009) describes how Tropical Storm Alberto came ashore near Keaton Beach, Florida on 

June 13, 2006 and weakened to a tropical depression before interacting with a shortwave 

trough and dumping heavy rains across much of central North Carolina on June 14.  A 

map of the precipitation from this storm event is shown in Figure 3 below.  This figure 

shows the locally heavy rainfall that occurred, some of which was at the headwaters of 

the Tar River. 

 

Figure 3: Precipitation in North Carolina due to Tropical Storm Alberto, 
which dumped heavy rains over the central region of the state on June 14, 2006. 

Two months later, Tropical Storm Ernesto came ashore at the southern coast of 

North Carolina on August 31, 2006 and moved northward across the state, with some of 

the heaviest rainfall occurring in the Tar River watershed near Greenville, NC.  The 

general track of the storm follows the band of heavy precipitation seen in Figure 4 below.  
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Figure 4: Precipitation in North Carolina from Trop ical Storm Ernesto, which 
made landfall on August 31, 2006. 

The  multiple heavy storm events during the summer of 2006, although without 

post-event studies at the level of detail of those conducted after Hurricane Floyd, 

provides a good opportunity to test the ability of a hydrologic-hydraulic model system to 

simulate other large events. 

3.3 Models Used  

In this study, a hydrologic model (HL-RDHM) was loosely coupled with a 

hydraulic model (HEC-RAS) with different numbers of connections in four distinct 

scenarios to explore the effect these scenarios will have on mapping and stage and flow 

accuracy.  A schematic of the model linkages is shown below, in Figure 5. 
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Figure 5: Flowchart of models, programs, and their generated outputs used 
in this study. 

3.3.1 HL-RDHM 

Outputs were generated from a run of HL-RDHM for the whole Lower Tar River 

sub-basin.  The parameters used for HL-RDHM runs were based on a-priori parameter 

estimates combined with information from calibrated lumped parameters used at the 

Southeast River Forecast Center and some manual adjustments to potential 

evapotranspiration parameters to improve multi-year seasonal and overall bias statistics. 

It was not possible to do a comprehensive hydrologic model calibration given the 

resources available for this study.  Two sets of data were generated: one from September 

1, 1999 to December 1, 1999 for the simulation of flooding due to Hurricane Floyd and 

the other from June 1, 2006 to October 1, 2006 for the simulation for Tropical Storm 

Alberto in June and Tropical Storm Ernesto in August.  These runs generated hourly 
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discharge, surface flow and subsurface flow data for a ½-HRAP grid, or 2 by 2 km cells.  

The calculation method of these flows is described previously in Section 2.1.1.   

3.3.2 HEC-RAS 

Previous work involved development and calibration of a HEC-RAS model for 

the main stem of the Tar River between Tarboro and Washington, NC (Cepero-Pérez, 

2011; Reed, 2010).  The model contained 103 cross sections, three of which were 

interpolated.  Cepero-Pérez (2011) explored the effects of using Manning’s n values 

corresponding to land cover types obtained from sampling a digital map to improve 

simulations for the same time period by spatially varying roughness, but did not see a 

significant difference between the more complex scenario and using a simplified scheme 

where channel and floodplain roughness did not change along the reach.  That study 

suggested using a calibrated distributed model to generate lateral inflows to the model as 

a way to improve simulation results.  For the purpose of this study, the varied Manning’s 

n values were used.  The calculation of flow by HEC-RAS is described previously in 

Section 2.2.2. 

Additional models were obtained for the four tributaries from engineering studies 

conducted by the North Carolina Floodplain Mapping Program (NCFMP).  A HEC-RAS 

model for the upper reach, plus two HEC-2 models for the lower reach were obtained for 

Town Creek, which, when combined had 170 cross sections.  One HEC-RAS model with 

151 cross sections was obtained for Conetoe Creek, and two HEC-RAS models, one 

detailed and one limited in detail was obtained for Grindle Creek, with 151 cross 

sections. One limited detail HEC-RAS model with 168 cross sections was obtained for 
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Tranters Creek.  Manning’s n values and bank station locations for the tributaries were 

assigned as a part of these engineering studies and were not modified. 

3.4 Processing Steps 

Although a calibrated model existed for the main stem of the Tar River for the 

study area, several steps had to be taken to create a multi-reach model suitable for 

inundation mapping.  The HEC-RAS models obtained from NCFMP for Town, Conetoe, 

Grindle and Tranters Creeks did include surveyed cross-sections with station and 

elevation data, but the stream centerline was a straight line, and thus unsuitable for 

generating an accurately oriented flood map.  These tributary models first had to be 

georeferenced to match the spatial orientation of the true stream channel, and then 

incorporated into the pre-existing main stem model to create a multi-reach model capable 

of simulating floods in the whole Lower Tar River sub-basin. 

3.4.1 Georeferencing and creation of a multi-stem h ydraulic model 

Shapefiles of the tributary channels and cross sections were obtained from 

NCFMP and were imported into ArcGIS.  Using the HEC-GeoRAS interface, the river 

channel and cross sections were digitized for each tributary, and then exported using the 

“Export RAS Data” function.  In the Geometric Data window in HEC-RAS, these GIS 

data were imported into an existing, non-georeferenced reach, using the “Match to 

Existing” feature.  Examples of geometry for Conetoe Creek before and after 

georeferencing are shown in Figure 6.   A more complete explanation of georeferencing 

steps used here is included in Appendix A.  
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Figure 6: The image on the left is the tributary model as obtained from NCFMP, which is not suitable for inundation 
mapping.  The image on the right is the same model after the georeferencing process. 
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Each tributary and its cross sections were added in a similar way.  In the 

Geometric Data window of the main stem Tar model, HEC-RAS Data was selected using 

the Import Geometry Data function.  A junction was added to connect the tributary 

channel to the Tar River channel, in between cross sections determined by visual 

inspection of the stream network in ArcGIS.  A small cross section was added near the 

junction, in order to minimize calculation errors due to a long downstream length 

between the last surveyed cross section on a tributary and the junction with the main 

channel of the Tar River, a distance which could be several miles.  This full, multi-stem 

model contained 800 cross sections, 59 of which were interpolated.  The completed, 

multi-stem model is shown below in Figure 7. 
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Figure 7: The full georeferenced Tar River model as viewed in HEC-RAS, with all the channels and cross sections. 
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3.4.2 Creation of inputs to HEC-RAS 

A shapefile representing the ½-HRAP grid and flow path network for the basin 

was obtained, on which stream centerlines and model cross sections were overlaid in 

ArcGIS.  Cells which made up the stream and tributary channels modeled with the 

hydraulic model were identified, and a new shapefile with one point in each cell was 

created.  This shapefile was used for extraction of HL-RDHM data calculating surface 

and subsurface flows, as described in more detail in following paragraphs.  An example 

of this shapefile is shown as “Surface and Subsurface Flow Points” in Figure 8.  Points 

immediately adjacent to these channel cells were also written to shapefiles for use in 

generating discharge from HL-RDHM, and are shown as the “Discharge Points” in 

Figure 8.   

In the shapefile properties, afield was created named “Id”.  This was manually 

edited and points were assigned “Id” numbers such that points sharing the same “Id” 

number corresponded to the same HEC-RAS input.  In this way, multiple grid cells 

would be summed together to represent surface or subsurface flow applied to a single 

channel or flow from an area contributing to a single lateral inflow.  “Id” categories and 

areas of grouped inflow were determined from visual inspection in ArcGIS.  An example 

of the HRAP grid (color-coded to show cell type, either channel or hillslope), stream 

network and points for inflows of different types is shown in Figure 8. 



 

31 

 

Figure 8: Example of HRAP grid for RDHM, for Conetoe Creek showing 
different types of input points as distinct shapefiles. 

 

A Python script was written to generate a .txt file containing a list of cells and 

their HRAP coordinates grouped by “Id” number.  A second Python script then took the 

groups and coordinates and generated a sum of discharge, surface flow or subsurface 

flow, as specified by the user for all cells in a group.  This time series was then saved in a 

HEC-DSS compatible file, which could be input as a boundary condition in a HEC-RAS 

simulation.  For upstream boundaries and point inflows, discharge time series at a point 

were used.  For uniform lateral inflows, surface and subsurface flow and discharge time 

series were summed using the Math Functions in HEC-DSS to create a single time series 

to be used in the model as a lateral inflow.  The number of these inflows varied for the 

different scenarios examined, as discussed in the next section 
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3.5 Scenario Description 

Four different scenarios were created using different configurations of lateral 

inflows and different model complexities.  The first and most basic scenario was the 

calibrated main stem model with only upstream and downstream boundary conditions 

from observed USGS data, no lateral inflows.  These upstream and downstream 

boundaries were used consistently throughout the model scenarios.  This was considered 

the simplest and most basic of the scenarios. This schematic is attached on the next page 

in Figure 9.  This was the only scenario of the four to not have a similar total flow at 

Greenville for this study period.
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Figure 9: A conceptual map of the Lower Tar sub-basin with inputs configured as Scenario 1. 
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The second used the same main stem model, but represented the outlets of each of 

the four tributaries as point inflows, represented in HEC-RAS as lateral inflow 

hydrographs, using data generated from RDHM.  The discharge from grid cells, whose 

flow entered the main channel of the Tar between tributary inputs, summed with the 

surface and subsurface flow calculated from for the 2 km grid cells considered part of the 

“channel” in RDHM as uniform lateral inflows, was modeled in HEC-RAS as a uniform 

lateral inflow along the channel between the tributary inflows. This model included 5 

lateral inflows, which added inflow from areas averaging 193.6 km2 and 4 point laterals, 

with drainage areas averaging 358 km2.  This scenario most closely represented previous 

model testing and set-up as obtained from the NWS.  This schematic is attached on the 

next page in Figure 10. 
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Figure 10: A conceptual map of the Lower Tar sub-basin with inputs configured as Scenario 2. 
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The third scenario used the multi-stem HEC-RAS model, and again represented 

the flow entering the channel between tributaries added to the surface and surface flow 

along the channel as uniform lateral inflows.  An upstream inflow point for each tributary 

was designated by inspection of the grid, and the discharge calculated by RDHM from 

this cell was designated to be the upstream boundary at this point.  Any cross section 

upstream of this point was eliminated.  Each of the grid cells which flowed into the 

tributary channel, as well as the surface and subsurface flow calculated for the grid cells 

which made up the tributary channel in RDHM were summed and applied to the HEC-

RAS tributary model as a uniform lateral inflow for each tributary.  This model included 

runoff from 5 lateral inflows, which added inflow along the main stem from areas 

averaging 193.6 km2, 4 upstream inflows to tributaries whose drainage areas averaged 59 

km2, and uniform lateral inflows along the tributary of average drainage area 299 km2.  A 

schematic of this scenario layout is attached on the next page in Figure 11. 
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Figure 11: A conceptual map of the Lower Tar sub-basin with inputs configured as Scenario 3. 
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The fourth, and most complex scenario maintained the same configuration of 

lateral inflows on the main stem of the Tar River.  The tributary models maintained the 

same inflow conditions, but via visual inspection of the RDHM flow network, the cells 

which contained major inflows to the tributaries were selected to be point inflows, with 

the idea that these would represent inputs from major tributaries of Town, Conetoe, 

Grindle and Tranters Creeks.  Three such inflows were identified for Town, Conetoe, and 

Tranters Creek, with one inflow along Grindle Creek.  The remaining cells whose waters 

entered the tributaries, along with the surface and subsurface flow from the tributary 

channel cells were summed and applied to the reach as uniform lateral inflows along the 

tributary.  This simulated runoff from 5 lateral inflows along the main stem from areas 

averaging 193.6 km2, 4 tributary inflows to the upstream of each tributary model, which 

averaged drainage areas of 59 km2, and uniform lateral inflows along the tributary of 

average drainage area 126 km2 and tributary point inflows of an average of 98 2/3 km2 of 

drainage area to Town Creek, 40 km2 average point inflow to Conetoe Creek, one point 

inflow of 24 km2 along Grindle Creek, and point inflows averaging 84 km2 to Tranters 

Creek.   A schematic of this scenario layout is attached on the next page in Figure 12. 
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Figure 12: A conceptual map of the Lower Tar sub-basin with inputs configured as Scenario 4. 
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3.6 Adjustments 

After importing some cross sections to HEC-RAS and adding the tributary models 

to create a multi-reach model, it was observed that some cross sections overlapped, 

especially where tributaries were added to form the multi-stem model.  To prevent 

miscalculation due to overlapping cross sections, the length of overlapping cross section 

was measured in ArcGIS.  The length to be cut was determined from visual inspection in 

ArcGIS and measured using the “Measure” tool.  Then, the endpoint of the cross section 

selected was shortened in HEC-RAS by the measured amount.  

Another problem encountered was that some of the cross sections generated from 

the HEC-2 model for Town Creek were oriented backwards when viewed in HEC-

GeoRAS.  Since few cross sections were affected and no better data were available to 

validate how the cross section should be oriented, this was easily fixed by right clicking 

on a cross section in the Geometric Data window, and selecting “Reverse XS Stationing”.   

In order to create a stable model run, model geometry had to be adjusted by 

adding interpolated cross sections along sections of reaches where surveyed cross 

sections were far apart and where the change in elevation was relatively steep.  Seventy-

three cross sections were interpolated on Town Creek, one on Conetoe Creek, and one on 

Tranters Creek.    Another area of adjustment was setting minimum flow levels at the 

upstream-most cross section of some channels.  The very low flow during some periods 

of low flow, combined with areas of steep relief can create instability in the model.  By 

specifying minimum flows of 100 cubic feet per second at the top of Town Creek and 

Grindle Creek, enough flow is maintained in the channels to keep the model calculations 
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stable, while not enough to generate overbank flows.   Minimum flows of 400 cubic feet 

per second, 100 cubic feet per second, and 100 cubic feet per second were applied along 

the first, second, and third segments of the main stem model, respectively, to ensure 

stability of the model for the 2006 simulation period.  An explanation of model set-up 

and simulation is more fully described in Appendix B.   

3.7 Generating Inundation Maps 

After a simulation was run, post-processing was performed in HEC-RAS to 

generate water surface profiles.  This generated a water surface profile for every selected 

time period, set for one hour in this study, as well as a “maximum water surface” which 

included the maximum water surface height at each cross section.  For inundation 

mapping, this maximum water surface was the profile used to create the water extent.  

Using the Export GIS data function in HEC-RAS, the maximum water surface profile 

was exported for each scenario.  Then, HEC-GeoRAS functions are used to generate 

layers.  GeoRAS then imported layers, which are the cross sections, stream channel, and 

a bounding polygon, which was set as the extent of the mapping.  The inundation 

mapping function then generated a water surface TIN, from which the terrain DEM was 

subtracted, and a raster of flood depths was created.  This terrain was obtained from the 

20 foot resolution LiDAR data available from the NCFMP website.  A more complete 

description is included in Appendix C.    

3.8 Validation Data 

Hourly stage and discharge data, where available, were obtained for USGS stream 

gauges along the main stem and tributaries being modeled.  The stage and flow records 



 

42 

on the tributaries of the Tar River (Conetoe, Town, and Tranters Creeks) were only used 

in the scenarios involving the multi-stem model, since this was the only time flow was 

simulated for these reaches.  The data were adjusted to elevation using the datum 

provided for each gauge to allow comparison with the water surface elevation modeled in 

HEC-RAS.  These records were used to validate stage and flow simulations performed by 

the model both during the Hurricane Floyd simulations and model run encompassing 

flooding due to Hurricane Alberto, depending on data availability.  A shapefile of the 

locations of these stations was obtained from NOAA’s OHD, and when combined with 

georeferenced model data, the stream gauge was matched to the closest model cross 

section to allow comparison with simulated data.  A listing of this information is included 

in Table 1. 

Table 1: USGS Gauges for Observed Data 

Gauge Name 
Gauge 

Number 
Parameters 
Measured 

Dates of 
Operation 

Simulations 
Used 

RS 
Location 
in Models 

Tar River at US 
264 Bypass Near 
Rock Springs, NC 

02083893 Stage 
06/24/2003 – 

present Alberto 
Main 

Channel 
131841 

Tar River at 
Greenville, NC 02084000 

Stage, 
Discharge 

10/01/1984 – 
present (stage) 
04/23/1997 – 

present (present) 

Floyd, 
Alberto 

Main 
Channel 
104466.6 

Tar River at SR 
1565 near 

Grimesland, NC 
02084173 Stage 05/03/2003 – 

present Alberto 
Main 

Channel 
30339.3 

Conetoe Creek at 
Conetoe, NC 

0208378372 
Stage, 

Discharge 
07/01/2002 – 
06/30/2003 

Floyd 
Conetoe 

Creek 
42991 

Town Creek at 
US 258 Near 
Pinetops, NC 

02083640 Stage 07/23/2003 – 
present 

Alberto 
Town 
Creek 
36880 

Tranters Creek at 
SR 1403 near 

Washington, NC 
0208436195 Stage 

06/24/2003 – 
present Alberto 

Tranters 
Creek 
40104 
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In order to quantify the fit of the model to observed data obtained from the gauges 

for each simulation, the index proposed by Nash and Sutcliffe (1970) was employed to 

characterize the efficiency of a model in reproducing observed values.  This formula is  

( )
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where Xmodel is the simulated  stage or streamflow at each hour interval, Xobserved is the 

USGS observed stage or streamflow, and X̄observed ,with values closer to 1 indicating a 

better “fit”. 

Additionally, since this project focuses on  inundation applications, a modified 

Nash-Sutcliffe efficiency, as proposed by Guex (2001) was used to determine the 

efficiency of the model at high flows or stages (as cited by Drogue, et al., 2003, p. 911).  

This method weights the higher discharges more heavily than the mean discharge.  The 

formula for this is 
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with values closer to 1 again signifying a better model fit to observed data. 

High water marks were surveyed after the flooding from Hurricane Floyd as part 

of a FEMA study post-event survey.  A team collected 87 high water marks in the 

modeled basin extent, including seed, mud, and debris lines, as well as water marks.  This 

was a large-scale study, and the locations high water marks across eastern North Carolina 

extend far beyond the current forecast basins, and even the current extent of the main 

stem HEC-RAS model.  The mean error for the high water mark points was calculated as 
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n

XX
ME obsel
 -

= mod      (14) 

where n is the number of observations, and the mean absolute error was calculated as 

n

XX
MAE obsel
 -

= mod      (15) 

Although satellite images were captured before and after Hurricane Floyd passed 

through the region, this was not used for validation or mapping verification due to a 

number of reasons.  First was the relatively low resolution of the data, only available in 

30x30 meter pixels. With some of the smallest channel cross sections spanning around 

150 meters, and generation of flood maps from a DEM at a resolution of 20 feet, it was 

thought the coarse resolution could hinder effective comparisons between models with 

only a slight difference in flooding extent. Second, and perhaps more importantly, is the 

uncertainty that arises from processing such data.  Previous studies have shown that the 

large amount of forested land and the inability of the radar to penetrate the forest canopy 

combine to create an underestimation of flooding extent (Wang, 2002). 
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4. Results 

For each cross section for which there were observed data at a USGS stream 

gauge, the Nash-Sutcliffe efficiency (NSE) and the modified Nash-Sutcliffe efficiency 

for high flows (NSH) were calculated for each scenario as compared to the observed 

flows.  Additionally, the percent root mean square error (percent RMSE) was calculated 

for each scenario with each observed gauge.  For the observed high water marks, the 

mean error and mean absolute error were calculated.  

4.1 Stage and Discharge Validation for Hurricane Fl oyd 

Figure 13 and Figure 14 show the observed stage and flow, respectively, plotted 

with the stage and flow simulated by each of the four scenarios. 
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Figure 13: Stage generated from scenarios 1,2, 3, and 4 as compared to partial 
USGS observed stage at Greenville, NC from September to November 1999. 
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Figure 14: Streamflow generated from scenarios 1, 2, 3, and 4 as compared to 
partial USGS observed stage at Greenville, NC from September to November 1999. 

 As described in the previous section, various statistics were calculated to 

determine the accuracy of the simulations.  A table of these for the simulation from 

September to November 1999 for the gauges at Greenville, NC is presented in Table 2, 

below. 

Table 2: Table of NSE, NSH, and % RMSE for the 1999 simulation period at 
Greenville, NC. 

 Greenville Stage 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 
NSE 0.931 0.978 0.979 0.979 
NSH 0.937 0.978 0.978 0.978 
% RMSE 7.64% 4.46% 4.30% 4.30% 
 Greenville Flow 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 
NSE 0.944 0.968 0.974 0.974 
NSH 0.953 0.969 0.975 0.975 
% RMSE 5.47% 4.46% 3.97% 3.94% 
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Figure 15 and Figure 16 present simulated stage and flow, respectively, as 

compared to the observed data for the USGS stream gauge on Conetoe Creek.  There is a 

period of no data where the stream gauge was out of operation due to flooding from 

Hurricane Floyd.  Figure 15 notes the level of a high water mark obtained in a post-event 

survey (Bales, et al., 2000).  Not shown in Figure 16 is an estimated a maximum daily 

mean discharge 15,000 cfs for September 18, 1999 (Surface-Water Daily Statistics for the 

Nation, http://waterdata.usgs.gov/nwis).  Backwater effects from the main stem of the Tar 

River can be clearly observed in both modeled scenarios around September 20, after the 

passage of most rainfall from Hurricane Floyd. 
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Figure 15: Stage generated from scenarios 3 and 4 as compared to partial 
USGS observed stage at Conetoe Creek from September to November 1999.  The 

pink line shows a post-Floyd high water mark. 
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Figure 16: Streamflow generated from scenarios 3 and 4 as compared to partial 
USGS observed stage at Conetoe Creek from September to November 1999.   

A table of statistics calculated to determine the accuracy of the simulations for the 

simulation from September to November 1999 for the USGS stream gauge at Conetoe 

Creek, NC is presented in Table 3.  There are no statistics for Scenarios 1 and 2, since 

these do not explicitly simulate tributary streamflow or stage. 

Table 3: Table of NSE, NSH, and % RMSE for the 1999 simulation period 
on Conetoe Creek, NC. 

 Conetoe Stage 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 
NSE -- -- -3.86 -5.66 
NSH -- -- -5.43 -7.65 
RMSE -- -- 8.45% 8.82% 
 Conetoe Discharge 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 
NSE -- -- 0.142 0.132 
NSH -- -- 0.255 0.271 
RMSE -- -- 34.09% 32.04% 
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4.2 Flooding Extents Modeled for Hurricane Floyd 

Maximum water surface profiles computed in HEC-RAS were exported to GIS 

files as described in the methods section.  A profile of these water surfaces are shown in 

Figure 17, Figure 18, Figure 19, and Figure 20 for Scenarios 1 through 4, with the most 

upstream cross section on the right of the figure and the downstream outlet on the left.  

These serve as a qualitative check of model stability, that the water surface computed and 

interpolated between cross sections is physically reasonable. 

Figure 21, Figure 22, and Figure 23 show the boundary of the maximum water 

surfaces for each scenario as calculated GeoRAS.  Scenarios 1 and 2 do not explicitly 

model stage on the tributaries, but the TIN generated by GeoRAS for inundation mapping 

is of great enough extent that some or all of the three eastern tributaries are sampled.  

This predicts flooding by projecting the water surface of the main stem at a tributary 

outlet upstream along the tributary.  Town Creek is not covered by the TIN in these first 

two models.  An explanation of map generation is presented in Appendix C.   

Although no validation data exist to quantify the accuracy of these boundaries, 

they are presented to show the difference in the extents of the main stem scenarios as 

compared to the multi-stem ones, and a comparison of boundaries within types.  Figure 

21 compares scenarios 1 and 2, which are main stem models only.  Figure 22 compares 

scenario 3, the least complex multi-reach model with respect to lateral inflows with 

scenario 2.  Figure 23 compares the two multi-reach models, scenarios 3 and 4.  

Additional maps show the flood extent overlaid on a topographic map of the city of 

Greenville, NC, and are an example of map generation for management decision-making.  

These are included in Appendix D. 
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Figure 17: Profile plot generated in HEC-RAS for the highest water surface at each cross section as generated from 
Scenario 1 for Hurricane Floyd. 
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Figure 18: Profile plot generated in HEC-RAS for the highest water surface at each cross section as generated from 
Scenario 2 for Hurricane Floyd. 
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Figure 19: Profile plot generated in HEC-RAS for the highest water surface at each cross section as generated from 
Scenario 3 for Hurricane Floyd. 
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Figure 20: Profile plot generated in HEC-RAS for the highest water surface at each cross section as generated from 
Scenario 4 for Hurricane Floyd. 
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Figure 21: Boundaries of flooding generated by scenarios 1 and 2 Hurricane Floyd (September 1999). 
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Figure 22: Boundaries of flooding generated by scenarios 2 and 3 Hurricane Floyd (September 1999). 
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Figure 23: Boundaries of flooding generated by scenarios 3 and 4 Hurricane Floyd (September 1999). 
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4.3 High Water Mark Validation 

Eighty-seven high water marks were surveyed after Hurricane Floyd in the area 

covered by the models in this study.  These were obtained in a shapefile with information 

about their elevation.  This was compared to the inundation elevation created in a raster 

in ArcGIS at each point where a high water mark was sampled for each of the four 

scenarios modeled.  Due to the shape of the TIN created by the GeoRAS processes, not 

every high water mark was compared for each scenario.  The two main stem models are 

unable to simulate the left-most tributary (Town Creek) and the most upstream high 

water marks on the downstream-most tributary (Tranters Creek) due to the shape of the 

main channel and the water surface raster generated for the sub-basin, even though the 

other tributaries are predicted because they fall under this water surface interpolation.   

Seventy-four high water marks were analyzed for Scenarios 1 and 3, and all 87 were 

analyzed for Scenarios 3 and 4. Figure 24 shows a map of the inundated area as predicted 

by the first scenario.  Each point on the map represents a high water mark location.  The 

points are color coded based on the difference between the simulated water elevation and 

the elevation of the surveyed high water mark, and values are shown in the legend.  

Figure 25 shows the same points for Scenario 2, Figure 26 shows Scenario 3, and Figure 

27  is a map of high water error for Scenario 4.  
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Figure 24: Comparison of model simulated high water at measured high water marks after Hurricane Floyd for 
Scenario 1. 
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Figure 25: Comparison of model simulated high water at measured high water marks after Hurricane Floyd for 
Scenario 2. 
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Figure 26: Comparison of model simulated high water at measured high water marks after Hurricane Floyd for 
Scenario 3. 
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Figure 27: Comparison of model simulated high water at measured high water marks after Hurricane Floyd for 
Scenario 4. 
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Table 4 presents the mean error, calculated by equation 14, and mean absolute 

error, from equation 15, which represent the accuracy of the inundation maps in 

predicting flood height as compared to measured high water marks.  Table 8 shows the 

mean error and Table 6 shows mean absolute error compared to location of the mark.  

These statistics are only for the 74 high water marks which all simulations had in 

common.   

Table 4: Mean Error and Mean Absolute Error in height of simulated high 
water mark by scenario, same 74 points 

 Mean Error Mean Absolute Error 
Scenario 1 0.89 3.56 
Scenario 2 1.13 3.56 
Scenario 3 1.72 3.98 
Scenario 4 1.58 3.92 

 
Table 5: Mean Error in height of simulated high water mark by reach and 

scenario, same 74 points 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 

Town Creek -4.75 -4.44 -4.42 -4.41 
Conetoe Creek 2.25 2.55 3.77 3.74 
Grindle Creek -1.24 -1.19 2.52 1.02 
Tranters Creek 2.01 2.06 2.86 3.11 
Tar Main Stem 0.86 1.15 1.02 1.02 

 

Table 6: Mean Absolute Error in height of simulated high water mark by 
reach and scenario, same 74 points 

 Scenario 1 Scenario 2 Scenario 3 Scenario 4 

Town Creek 4.75 4.44 4.42 4.41 
Conetoe Creek 2.93 3.17 3.77 3.74 
Grindle Creek 1.24 1.19 2.54 1.76 
Tranters Creek 2.01 2.06 2.86 3.11 
Tar Main Stem 4.36 4.30 4.47 4.46 
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Scenarios 1 and 2 had 13 fewer high water marks, due to the smaller area 

generated by GeoRAS.  For Scenarios 1 and 2, there was only one point measured on 

Town Creek while Scenarios 3 and 4 analyzed 11.  On Tranters Creek, only 8 high water 

marks were within the modeled area for Scenarios 1 and 2, but 11 are included for 

Scenarios 3 and 4. Table 7 gives the mean error and mean absolute error by simulation, 

Table 8 shows the mean error and Table 9 shows mean absolute error compared to 

location of the mark. 

Table 7: Mean Error and Mean Absolute Error in height of simulated high 
water mark by scenario, all available points for each scenario  

 Mean Error Mean Absolute Error 
Scenario 1 0.89 3.56 
Scenario 2 1.13 3.56 
Scenario 3 1.01 4.22 
Scenario 4 0.99 4.13 

 
 

Table 8: Mean Error in height of simulated high water mark by reach and 
scenario, all available points for each scenario 

 Scenario 1 Scenario 2 Scenario 3 Scenario 4 

Town Creek -4.75 -4.44 -4.92 -4.56 
Conetoe Creek 2.25 2.55 3.77 3.74 
Grindle Creek -1.24 -1.19 2.52 1.02 
Tranters Creek 2.01 2.06 3.03 3.60 
Tar Main Stem 0.86 1.15 1.02 1.02 

 

Table 9: Mean Absolute Error in height of simulated high water mark by 
reach and scenario, all available points for each scenario 

 Scenario 1 Scenario 2 Scenario 3 Scenario 4 

Town Creek 4.75 4.44 6.04 5.37 
Conetoe Creek 2.93 3.17 3.77 3.74 
Grindle Creek 1.24 1.19 2.54 1.76 
Tranters Creek 2.01 2.06 3.03 3.60 
Tar Main Stem 4.36 4.30 4.47 4.46 
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4.4 Validation for 2006 (TS Alberto) Time Period 

Five USGS stream gauges were active during the June to September 2006 

simulation period.  The observed data from these gauges was compared with flow and 

stage simulated by HEC-RAS for each of the four different scenarios.  The stage and flow 

time series for this time period, along with Nash-Sutcliffe efficiency (NSE), adjusted 

NSE (NSH), and percent root mean squared error (% RMSE) are presented in this 

section. 

A graph showing the stage simulated near Rock Springs, NC for Scenarios 1, 2, 3, 

and 4 as compared to observed data from a USGS stream gauge in that area is shown in 

Figure 28.  The high baseflows during the August 2006 period as simulated in Scenarios 

3 and 4 are due to the minimum flow conditions set for stability of this model, as 

described in section 3.6.  A table of statistics calculated to determine the accuracy of the 

simulations for the simulation from June to September 2006 for the USGS stream gauge 

at Rock Springs, NC is presented in Table 10.  
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Figure 28: Stage generated from scenarios 1, 2, 3 and 4 as compared to USGS 
observed stage at Rock Springs, NC from June to September 2006. 

 

Table 10: Table of NSE, NSH, and % RMSE for the 2006 simulation period 
at Rock Springs, NC. 

 Rock Springs Stage 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 

NSE 0.912 0.973 0.948 0.958 
NSH 0.923 0.970 0.956 0.962 
% RMSE 7.71% 4.58% 5.83% 5.32% 
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Figure 29: Stage generated from scenarios 1, 2, 3 and 4 as compared to USGS 
observed stage at Greenville, NC from June to September 2006. 
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Figure 30: Streamflow generated from scenarios 1, 2, 3 and 4 as compared to 
USGS observed stage at Greenville, NC for June to September 2006. 
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Stage and flow simulated at Greenville, NC for the time period from June to 

September 2006 are shown in Figure 29 and Figure 30.  Observed data are plotted, with 

stage and flow simulated for each of the scenarios.  A table of statistics calculated to 

determine the accuracy of the simulations for the USGS stream gauge at Greenville, NC 

is presented in Table 11.   

Table 11: Table of NSE, NSH, and % RMSE for the 2006 simulation period 
at Greenville, NC. 

 Greenville Stage 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 
NSE 0.902 0.956 0.946 0.951 
NSH 0.922 0.950 0.945 0.949 
% RMSE 7.26% 5.51% 5.88% 5.64% 
 Greenville Flow 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 
NSE 0.874 0.910 0.906 0.911 
NSH 0.917 0.908 0.910 0.915 
% RMSE 6.87% 6.66% 6.71% 6.54% 

 

Stage simulated at Grimesland, NC for the time period from June to September 

2006 is shown in Figure 31.  A table of statistics calculated to determine the accuracy of 

the stage for the 2006 simulation period for the USGS stream gauge is presented in  

Table 12.   
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Figure 31: Stage generated from scenarios 1, 2, 3 and 4 as compared to USGS 
observed stage at Grimesland, NC from June to September 2006. 

 
Table 12: Table of NSE, NSH, and % RMSE for the 2006 simulation period 

at Grimesland, NC 
 Grimesland Stage 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 
NSE 0.825 0.843 0.900 0.903 
NSH 0.879 0.794 0.890 0.892 
% RMSE 7.30% 8.97% 6.63% 6.55% 

 

Stage simulated at a stream gauge on Town Creek, a tributary of the Tar River for 

the time period from June to September 2006 is shown in Figure 32.  A table of statistics 

calculated to determine the accuracy of the simulations for the simulation from for the 

USGS stream gauge is presented in  
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Table 13.  There are no statistics for Scenarios 1 and 2, since these do not 

explicitly simulate tributary streamflow or stage. 
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Figure 32: Stage generated from scenarios 3 and 4 as compared to USGS observed 
stage at Town Creek from June to September 2006. 

 
Table 13: Table of NSE, NSH, and % RMSE for the 2006 simulation period 

on Town Creek. 
 Town Creek Stage 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 
NSE -- -- 0.365 0.465 
NSH -- -- 0.427 0.524 
% RMSE -- -- 11.44% 11.19% 

 

Stage simulated at a stream gauge on Tranters Creek, a tributary of the Tar River 

for the time period from June to September 2006 is shown in Figure 33.  A table of 

statistics calculated to determine the accuracy of the simulations for the simulation from 

for the USGS stream gauge is presented in  
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Table 14.  There are no statistics for Scenarios 1 and 2, since these do not 

explicitly simulate tributary streamflow or stage. 
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Figure 33: Stage generated from scenarios 3 and 4 as compared to USGS 
observed stage at Tranters Creek from June to September 2006. 

 
Table 14: Table of NSE, NSH, and % RMSE for the 2006 simulation period 

at Tranters Creek, NC 
 Tranters Creek Stage 
 Scenario 1 Scenario 2 Scenario 3 Scenario 4 
NSE -- -- 0.076 0.078 
NSH -- -- -0.002 0.002 
% RMSE -- -- 53.35% 53.03% 

 

4.5 Flooding Extents for 2006 Period 

Maximum water surface profiles computed in HEC-RAS were also computed for 

mapping for each scenario in the 2006 simulation period.  A profile of these water 
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surfaces are shown in Figure 34, Figure 35, Figure 36, Figure 37 for Scenarios 1 through 

4, with the most upstream cross section on the right of the figure and the downstream 

outlet on the left.  These can be compared with the maximum water surface generated for 

the 1999 simulation.  Since this period should simulate the maximum water surface for 

the storm of record for this basin, the water surfaces should be lower for this validation 

period. 

Figure 38, Figure 39, and Figure 40 show the boundary of the maximum water 

surfaces for each scenario as calculated by GeoRAS.  Although no validation data exist to 

quantify the accuracy of these boundaries, they are presented to show the difference in 

the extents of the main stem scenarios as compared to the multi-stem ones, a comparison 

of the boundaries within types, and as is true for the water surface profile, should be less 

than the boundaries calculated for the 1999 simulation period, which contained the storm 

of record.  Figure 38 compares scenarios 1 and 2, which are main stem models only.  

Figure 39 compares scenario 3, the least complex multi-reach model with respect to 

lateral inflows with scenario 2.  Figure 40 compares the two multi-reach models, 

scenarios 3 and 4.  High water mark data were not available during this time period, so no 

uncertainty analysis of this flood event was performed.   
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Figure 34: Profile plot generated in HEC-RAS for the highest water surface at each cross section as generated from 
Scenario 1 from June to September 2006. 
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Figure 35: Profile plot generated in HEC-RAS for the highest water surface at each cross section as generated from 
Scenario 2 from June to September 2006. 
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Figure 36: Profile plot generated in HEC-RAS for the highest water surface at each cross section as generated from 
Scenario 3 from June to September 2006. 
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Figure 37: Profile plot generated in HEC-RAS for the highest water surface at each cross section as generated from 
Scenario 4 from June to September 2006
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Figure 38: Boundaries of flooding generated by scenarios 1 and 2 for the time period from June to September 2006. 
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Figure 39: Boundaries of flooding generated by scenarios 2 and 3 for the time period from June to September 2006. 
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Figure 40: Boundaries of flooding generated by scenarios 3 and 4 for the time period from June to September 2006. 
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5. Discussion and Conclusions 

5.1 Uncertainty in Models 

Simulation of flows and stages on the main stem of the Tar River were very good: 

the Nash-Sutcliffe efficiency (NSE) and adjusted Nash-Sutcliffe efficiency (NSH) were 

generally very close to 1 for the comparison between simulated and observed flows and 

stage for both simulation periods.  Average NSE for all simulations for main stem 

observation points was 0.898 for Scenario 1, 0.938 for Scenario 2, 0.942 for Scenario 3 

and 0.946 for Scenario 4.  NSH values were still very good, but generally not as high.  

The only scenario which showed a better ability to predict high flows or stages as 

compared to all flows or stages was Scenario 1, where the average NSH on the main 

channel of the Tar River was 0.922.    Scenario 3 had the same NSH value as NSE, 0.942.  

The average NSH at the same points for the other scenarios were 0.928 for Scenario 2, 

and Scenario 4 was 0.945. Scenario 4 overall showed the best fit with observed data for 

points on the main stem of the Tar River.   

The NSE and NSH values showed a poor model prediction of observed data on 

the tributaries.  The NSE and NSH values for the 1999 simulation of stage on Conetoe 

Creek were negative, which means the modeled stage is not a good predictor of observed 

stage, that the average of the observed data is a better predictor of stage than the modeled 

data, and that the model is probably biased either in time or in stage magnitude simulated.  

Prediction for discharge at this point was not as bad, but was similarly low, with NSE and 

NSH for Scenario 3 0.142 and 0.255.  Scenario 4 showed a slight increase in efficiency in 

prediction of high flows with NSH improving to 0.271, but NSE slightly decreasing to 
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0.132.  It is important to keep in mind when considering these statistics at this gauge that 

there is a significant period of missing data, including the very highest flows.  Therefore, 

the NSE and especially NSH at this point may not reflect the true accuracy of the model. 

However, similarly poor efficiencies are found for the simulation of tributary 

stage during the second time period simulation with more complete data.  NSE and NSH 

for stage at Town Creek were best of all tributary simulations, 0.365 and 0.427 for 

Scenario 3 and 0.465 and 0.524 for Scenario 4, respectively for the simulation during 

2006.  The simulation of stage at Tranters Creek for the same time period was extremely 

poor, with Scenario 3 NSE and NSH 0.076 and -0.002, and Scenario 4 NSE and NSH 

0.078 and 0.002.  This suggests poor or no efficiency of model ability to reflect observed 

data.  

It is encouraging that the NSH for Town Creek stage is greater than the NSE, 

because the focus of the use of these models is for flood forecasting.  Even though this 

was not true for the majority of the simulation points, because the NSE and NSH are both 

so high on the main stem of the Tar River, the significance of any difference between 

these values as it relates to how well the modeled data fit the observed data may be 

negligible, as the whole range of stage and flows are very well predicted.    

It is thought that the better prediction of flows and stage on the main stem of the 

Tar River as compared to the tributaries is due to observed data providing the upstream 

and downstream boundary conditions, which may dominate model accuracy.  This was 

noted by Pappenberger, et al. (2005), who saw inaccuracies in flow due to the model 

forcing flow to meet the water balance at the downstream condition.  It may be that 



 

81 

inaccurately predicted flow in the main stem at a junction of a tributary could represent 

the same problem, a downstream boundary condition which strongly affects flow or stage 

in the tributary.  The propagation of error downstream in the main channel of this model 

was observed by Cepero-Pérez (2009).  Future studies should examine observed data 

close to the inflow of a tributary to see if a better fit of simulated main channel flow to 

observed data near the junction of a tributary with the main stem is correlated to more 

accurate simulation of tributary flow. 

Reed (2010) found that “a minimum standard for model calibration performance 

should be about a five percent RMSE error”.  On average for all simulations as compared 

to observed data on the main channel of the Tar River, percent RSME is around 7.04% 

for Scenario 1, 5.77% for Scenario 2, 5.56% for Scenario 3, and 5.38% for Scenario 4.  

This suggests gains can be made in error reduction on the main channel of the river from 

increasing model complexity.  Tributary percent RSME did not show such low values, 

with the average percent RMSE for all simulations and tributaries for Scenario 3 around 

26.8% and for Scenario 4 around 26.3%.  The lowest % RMSE was calculated for 

Scenario 3 stage on Conetoe Creek (8.45%) and the highest was a huge % RMSE of 

53.35% for stage simulated by Scenario 3 on Tranters Creek. At the same time, there is a 

huge overprediction of stage late in the 2006 simulation for Tranters Creek, which is 

discussed more in the next section. This could be an error from inputs to HL-RDHM or 

model instability, which would not be an issue with the downstream boundary of this 

tributary. Regardless of the source of this particular error, it is suggested that future 



 

82 

studies should use more tributaries with observed data available during the simulation 

period to confirm the effect of boundary conditions on ungauged tributaries. 

Interestingly, the errors in inundation mapping do not appear to follow this trend 

in error propagation as closely as the stages and streamflows.  Many scenarios have some 

of the least error at points very near the downstream boundary of the model, and low 

error at points taken along the tributaries.   Additionally, error was not significantly better 

near the upstream boundary condition, which would not be expected from the stage and 

streamflow error patterns.  The two most overpredicted points occur near a validation 

point on the main stem of the model.  It is thought that either the elevation of the flood at 

this point is recorded incorrectly, or that there are smaller scale effects (such as sheltering 

due to buildings or bridges) that cannot be observed by looking at a DEM which has been 

processed to remove some of these effects.  Increasing model complexity did not seem to 

significantly improve accuracy of predicting water height at given points, especially 

along the main stem, with little to no change in mean absolute error or mean error. Town 

Creek showed some consistent mean error with increasing model complexity and number 

of high water marks, but a large increase in absolute error for Scenarios 3 and 4, when 

including all inundation points.  The mean error for Town Creek stays about the same and 

the mean absolute error decreases slightly when only the points common to all 

simulations are compared.  Conetoe Creek, Grindle Creek and Tranters Creek showed an 

increase in mean error and mean absolute error with increasingly model complexity, 

though the errors decrease from Scenario 3 to Scenario 4 for Grindle Creek.  Although 

the main stem model can be considered well-calibrated with respect to stage and flow 
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prediction, there is still significant error in prediction of flood height at given high water 

marks, though the two highly overpredicted points mentioned previously do contribute to 

that error.  

5.2 Ease of Modeling Other Events 

As mentioned in section 5.1, NSE and NSH were very high for main stem 

observed data points for the simulation period during 2006, which had not previously 

been simulated by other studies in this basin.  However, a few issues were noted that may 

be decreasing model accuracy.  Strong overprediction of stage and flow towards the end 

of the 2006 simulation which cause very high stages and flows, as seen strongly in Figure 

33 showing simulated and observed stage at Tranters Creek, and less so due to backwater 

effects along the main channel in Figure 28, Figure 29 and Figure 31.  From preliminary 

investigation, this appears to be an over-expression of localized runoff due to Tropical 

Storm Ernesto, with observed data showing a very steep, sharp peak of stage or discharge 

during this time period, but the modeled data showing a higher and broader curve, 

especially at the downstream portion of the model and in the more downstream 

tributaries.  It is unknown whether the problem lies with faulty input, in which case the 

error would be from HL-RDHM, either in magnitude or timing, or whether the model is 

overexpressing backwater effects.  Identifying the source of this problem was not within 

the scope of this work, but it serves as an important example that a model which is well 

calibrated for one time period may not simulate a different time period with the same 

accuracy. 
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5.3 Lessons Learned and Recommendations 

Overall, increasing complexity did increase the efficiency in modeling stage and 

streamflow, as well as high stage and streamflow for the main stem of the Lower Tar 

River sub-basin.  However, the high NSE, NSH and low percent RMSE values are only 

true where observed data provide upstream and downstream boundary conditions.  Using 

hydrologic model-generated upstream boundary conditions and modeled stage or flow in 

the main channel as downstream boundary conditions for tributaries did not produce 

simulations with high efficiencies or low RMSE.  The error seemed to increase in the 

downstream direction for both the main stem and the order of tributaries, suggesting that 

uncertainty in the downstream boundary condition provided by the model may negatively 

impact the accuracy of stage or flow in tributaries without forcing by observed data.   

The error in height of inundation at observed high water marks showed little trend 

with increasing model complexity.  No obvious trends were seen correlating error to 

channel type (main stem or tributary) or distance to upstream or downstream boundary 

condition with increasing model complexity.  The error in streamflow or stage prediction, 

which seemed to increase with distance downstream, did not seem to be correlated with 

error in high water height, which was often better at the downstream boundary than 

points farther upstream, and which varied greatly even in among points close together. 

Operationally, there is not much time difference involved in running a simulation 

of more complex geometry:  most of the time investment is taken in the post-processing 

component to create water surface heights of interest at different time steps.  However, 

there is greater time involved in georeferencing and integrating all the parts to a more 
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complicated model and then ensuring stability.  It is important to note for operational use 

that an overall well-calibrated model with high efficiency and low percent RMSE may 

still have large errors in prediction of water surface heights during flood events, so the 

application for this method in creating detailed inundation maps still appears to be 

limited. 

5.4 Future Work 

For future work, it is recommended to obtain aerial photography for inundation 

extent where available, in order to better calibrate inundation maps.  Since this was not 

available, no quantitative conclusions could be drawn about the extent of inundation 

produced by the model.  It would be valuable to compare the accuracy of inundation 

extent along with the accuracy of high water height, to see whether the extent of flooding 

correlates to areas of over or underprediction of with flood height, or whether the models 

should simply be calibrated to improve inundation height. The model could also be 

calibrated to produce higher NSH as compared to NSE, to see if this would produce 

greater accuracy in flood height generated at the high water marks.  

Another recommended approach would be to isolate the effect of boundary 

conditions on tributary flow and stage efficiency and error.  By using observed data as the 

upstream boundaries of a tributary, the effect of error in the downstream boundary could 

be quantified, and simulated discharge and stage as well as inundation mapping results 

for the model could be improved.  
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Appendix A 

Georeferencing HEC-RAS model data in GIS 
Set-up in GIS 
GeoRAS > ApUtilities >Create New Map 
Assign projection to map (or import a correctly projected terrain map) 
Add terrain GRID (check projection) and desired XS (check projection), save the map 
Create new River and XSCutLines layers (GeoRAS > RAS geometry > Create RAS 
Layers > Stream Centerline and GeoRAS > RAS geometry > Create RAS Layers > XS 
Cut Lines 
Close ArcMap, open ArcCatalog 
ArcCatalog > Select River, right click, Load > Select stream shapefile (make sure it is 
already projected and in one piece, not multiple segments), repeat for cross sections 
Return to GIS, GeoRAS > ApUtilities > Assign UniqueID 
GeoRAS > Assign RiverCode and ReachCode to River > Give the channel a name 
GeoRAS > Select Flowpath and Assign LineType Attributes > Select the river shapefile 
as the Channel 
GeoRAS > RAS geometry > Stream Centerline Attributes > All 
GeoRAS > RAS geometry > XS Cut Lines Attributes > All (check names of layers in this 
new window) 
Sort XS descending by station name, check to make sure they are in spatial order 

If not, there is probably a break somewhere in the stream centerline that needs to 
be fixed 

Editor> Modify Feature (having Snap to Vertex helps) and make the endpoints 
meet 

Will have to re-do starting at UniqueID step 
Editor > Start editing > copy and paste station names from original XS file (to match 
what is in HEC-RAS) 

When finished, remember to save and stop editing 
GeoRAS > RAS geometry >Export RAS Data (New Export Method, but I don’t know the 
difference) 

 
Importing into HEC-RAS 
Open HEC-RAS project file 
Open Geometry Window 
File > New Geometry  
File > Import Geometry Data > GIS format 

Check US customary units, Import stream, only check “GIS cut lines”, “reach 
lengths” for XS 
File > Import Geometry Data > HEC-RAS format 

US Customary units 
Uncheck River Reach Stream Lines, Change Import River and Reach As to match 

GIS 
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Cross Sections:  Increase Matching tolerance to 0.5, click Match to Existing, THEN 
uncheck BR/Culv, IS, LS, Names/Descriptions, Reach Lengths, and click Check Existing 
(order is important) 
Tables>Reach Lengths > copy from channel to left and right overbanks 
May need to delete empty cross sections, edit steady flow data for new plan (XS names, 
etc.) 
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Appendix B 

Example HEC-RAS Set-Up and Run 

1.  The georeferenced models were loaded into the Geometric Data window by 

going to the File menu and selecting Import Geometry Data > HEC-RAS Format and 

choosing one of the geometries created through the georeferencing process. 

2.  All the default settings were accepted.  Manning’s n values obtained with the 

models were left unchanged during this simulation.  Bank stations were adjusted as 

needed via visual inspection.  An example cross section is shown in the figure below. 

 

3.  The simulation flow file for the plan was created by returning to the main HEC-

RAS window and selecting Edit > Unsteady Flow Data. 

4.  Under the “Add Boundary Condition Location”, “Add RS” was selected, and the 

cross section where the inflow would start was selected.   
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5. The Boundary Condition Type was selected for the appropriate inflow.  Upstream 

boundaries were input as “Flow Hydrograph”, lateral inflows were input as “Uniform 

Lateral Inflow”, point laterals were characterized as “Lateral Inflow Hydr.” And the 

downstream-most boundary on the main stem was input as a “Stage Hydrograph”.  An 

image of the Unsteady Flow set-up window for the actual simulation for Scenario 4 is 

shown below. 



 

90 
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6. These boundary conditions were then linked to the DSS file generated via the 

DSS processing by selecting “Select DSS File and Path”, navigating to the saved file, and 

selecting the appropriate records.  An example of this selection window is shown in the 

image below. 

 

7.  Initial conditions were set based on observed data close to each upstream 

boundary, so that they wouldn’t be too high or low so as to impact model stability.  These 

values are shown in the following figure. 
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8. To ensure model stability, flow minimums were also added to the flow file, by 

selecting “Flow Minimum and Flow Ratio Table” was selected from the “Options” menu.  

These values were adjusted experimentally to obtain a stable simulation.  The values of 

these minimum flow values are shown in the figure below. 
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9. In order to compare these simulations to observed data during the simulation, 

observed data were added from DSS files obtained for the stream gauges listed in Table 

1.  To select these, the Option menu is selected on the flow file window, then “Observed 

(Measured) Data” and “Time Series in DSS”.  In this new window, the River, Reach and 

cross section location (“River Sta.”) where the observed time series are located were 

selected from the drop down menus, and then “Add selected location to table” was 

clicked.  The associated DSS file was then selected from the drop down menu, or by 

navigating through folders by clicking the folder icon, and the “Select DSS Pathname” 

was clicked to assign the DSS file to the cross section. 

10. The flow file was uniquely named, and then saved. 
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11.  To run the simulation, “Unsteady Simulation Analysis” was selected from the 

main HEC-RAS window Run menu.  The geometry file created in steps 1 and 2 and the 

flow file created in steps 3-6 were added to the analysis.   

12. Under Options, Flow Roughness Factors was selected.  These were assigned in 

previous modeling efforts on this basin to increase model stability.  These values were 

applied to every reach in the basin, and their values are shown in the figure below. 
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13. The Programs to Run were the Geometry Preprocessor., the Unsteady Flow 

Simulation, and, when mapping was to be performed, the Post Processor, which was the 

step which required the most time in the simulation.  The Computation Interval was set to 

6 minutes, the Hydrograph Interval was set to 1 hour, and the Detailed Output Interval 

was set to 6 hours.  An example of this set-up for Scenario 4 for the 1999 simulation 

period is shown in the following figure. 
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Appendix C 

Procedures for GeoRAS Mapping Using a Manually Edited Bounding Polygon 

Created by: Seann Reed 

Modified by Kate E. Abshire: 3/20/2012 

1. Create a new directory to store GeoRAS results. 

2. Export sdf file from HEC-RAS for plan and profiles of interest.   

Example: 

  

3. Open a blank ArcMap project 

4. Convert the sdf file to xml 

5. Save the ArcMap project.  This step is required to proceed with the following 

steps. 

6. Run layer setup.  Example: 
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7. Run “Import RAS Data” 

8. Save the project and close ArcMap. 

9. Open ArcCatalog, locate the BoundingPolygons class and “Load” data from a 

previously edited bounding polygon data set.  Accept all of the default options 

from the dialog choices. 

10. Re-open your ArcMap project and examine the table describing the 

BoundaryPolygons data set.  There are two polygon records as illustrated in the 

screen shot below.  By highlighting the records, it can be observed that one is the 

original bounding polygon defined by the cross-section extent and one is an edited 

bounding polygon. 
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11. Right click on the Bounding Polygon layer and select Edit Features �  Start 

Editing.  Now delete the first record from the Bounding Polygon Table, save the edits, 

and stop editing.   

12.  Select Layer Setup and use the Existing Analysis option. 

 

13. Run “Import RAS Data” again.  The edited shape definition for the Bounding 

Polygon does not get over-written.  The purpose of this step is just to get HEC-GeoRAS 

to re-recognize the input layers.   

14. Run “Water Surface Generation” 

15. Run “FloodPlain Delineation Using Rasters”.  The screenshot below shows an 

example of the results, zoomed in on the lower part of Town Creek where the cross-

sections are too narrow and the edited bounding polygon is much different from the 

original.   
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Appendix D 

Inundation Mapping in Greenville, NC: High Water during Hurricane Floyd 

Flood Boundary Comparison

Scenario 1

Scenario 2
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Flood Boundary Comparison

Scenario 2

Scenario 3
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Flood Boundary Comparison

Scenario 3

Scenario 4
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